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1. Getting Start with Your DrillBit Account 

13th Nov 2024 

 

Welcome to your comprehensive plagiarism detection service. 

DrillBit is excited to help you get started with setting up and 

accessing your account. Whether you’re an administrator 

overseeing multiple users or an individual checking your content, 

this guide will walk you through the essential steps to ensure 

you’re fully equipped to use DrillBit effectively. 

1. Check Your Inbox: Once your license is created, look for a 

welcome email from DrillBit. This email contains your login 

credentials and a direct link to the DrillBit application for easy 

access. 

2. Find Your Login Details: The email will provide your 

username, password, and a convenient link to sign in to 

DrillBit. Note that your username might be the same as your 

email address. 

3. Log In: Enter the username and password you received in the 

welcome email. 

4. Update Your Password: For security, you can update your 

password after your first login. Ensure your new password 

meets these criteria: 

a. at least 8 characters long 

b. at least 1 uppercase and lowercase 

c. at least 1 number 

d. at least 1 special character 

5. Bookmark the Login Page: To ensure quicker access in the 

future, consider bookmarking the login page. 
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2. Logging in to DrillBit Plagiarism 

22nd Nov 2024 

 

Getting started with DrillBit is easy. Simply log in using your 

credentials to access your dashboard and start managing your 

plagiarism checks. If you encounter any login issues, don’t 

worry—DrillBit is here to help you get back on track quickly and 

smoothly. 

1. Log In to DrillBit:  

Begin by using the credentials provided to you by DrillBit. 

These details, including your username and password, are 

typically sent to your email. 

2. Access Your Account:  

Visit drillbitplagiarism.com to log in. You’ll also find this link 

in your DrillBit welcome email. 

• For convenience, bookmark this URL to make future 

access easier. 

3. Initiate the Login Process:  

On the DrillBit homepage, locate and click the "GET 

STARTED" button. This will redirect you to the login screen 

where you can securely enter your credentials. 
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Check your inbox, spam, or junk folder if you don’t see the 

email. If you’re unable to locate it, contact your DrillBit sales 

representative or authorized partner for assistance. 

 

 

https://drillbitplagiarism.com/


  

  

 

 

Enter Your Credentials: On the login page, enter your username and password in the 

respective fields. 

 

 

 

4. Sign In: After entering your credentials, click the “Sign In” button to access your account 

and start exploring the features on your dashboard.

After 6 consecutive incorrect login attempts, your account will be temporarily locked 

for one hour. 

If you forget your password, click the “Forgot Password” link to reset it and regain 

access. 

 

your username may be the same as your email address. 

 



  

 

 

3. Forgot password 

18th Nov 2024  

If you've forgotten your password, no worries! Simply click on the 

"Forgot Password" link during login, and you’ll receive instructions 

to reset it. This ensures you can quickly regain access to your account 

without any hassle.  

Start by visiting the DrillBit login page and clicking the "Forgot 

Password" link. 

 

Then, enter the email address associated with your DrillBit account and click "Submit" to 

proceed. 
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Check your email for a password reset link from DrillBit. Be sure to check your inbox, spam, 

or junk folder if the email doesn’t appear immediately. 

Open the email, click on the reset link, and enter your new password. Confirm the password 

by re-entering it and click "Submit" to finalize the change.  

 

Once updated, return to the login page and access your account using your new password. 

 

 

 

 

 

Your password must contain: 

a. at least 8 characters long 

b. at least 1 uppercase and lowercase 

c. at least 1 number 

d. at least 1 special character 

 

 



  

 

 

Admin profile 

4. Switch Roles: From Admin to User 

18th Nov 2024  

Administrators can easily switch to a user account within the DrillBit 

application, allowing them to submit reports or perform tasks that require 

user-level access. This flexibility ensures that administrators can handle 

different responsibilities without needing to log in separately. 

To do this, log in to the DrillBit application using your admin username 

and password. Once logged in, click on your profile icon in the top right 

corner to open the dropdown menu.  

From the list of options, select 'Switch Account' to switch to a user 

account. 

 

After switching, you can carry out tasks such as submitting reports or any other activities that require 

user permissions. To return to your admin account, follow the same steps, but this time select 'Switch 

Account – Switch to Admin' from the dropdown menu. 

 

To switch back to the admin account from the user account, you can follow the 'Switch Roles: 

From User to Admin' guide for more information. 
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5. Switch Roles: From User to Admin 

17th Dec 2024  

Users who also have administrative privileges in DrillBit can easily switch 

their role from User to Admin. This functionality is particularly useful 

when a user needs to access administrative features after working within 

the User account.  

Switching roles from User to Admin allows individuals who manage both 

user-specific tasks (like submitting reports) and administrative duties to 

efficiently toggle between their roles without needing to log out and back 

in. 

• Navigate to the top right corner of the DrillBit interface, click your 

profile name, and select 'Switch to Admin' from the dropdown menu. 

 

o After selecting the option, the application will switch your user account to admin mode. 

o You will now have access to all administrative features and tools within the DrillBit 

application. 
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To switch back to the user account from the admin account, you can follow the ‘Switch Roles: 

From Admin to user’ guide for more information. 

 



  

 

 

6. Admin Account/License information 

13th Nov 2024 

This area offers key details about your account and license status, 

keeping you informed about your current standing. It’s your go-to 

spot for understanding the specifics of your license and ensuring 

everything is up-to-date and running smoothly. 

1. Log in to the DrillBit application. 

2. Select your profile from the top right corner. 

3. Choose 'Account Info' to view all your account details. 

 

4. In the Account Info section, administrators can upload a logo by selecting 'Upload Logo'. 

 

 

 

 

• The total upload size must not exceed 10 MB. 

• The image file must be in JPG or PNG format and can have a resolution 

of up to 1000 × 1000 (mm). 
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7. Accessing the Admin Help Section 

18th Nov 2024 

The help section offers a wealth of resources to ensure you make the 

most of the DrillBit application. Whether you’re an administrator or 

a user, you’ll find helpful video tutorials and PDF guides covering a 

range of features and functionalities. These materials are designed to 

assist you in navigating the application with ease and to answer any 

questions you might have. 

1. Log in to the DrillBit application. 

Enter your username and password on the login page to access 

your account. 

2. Select your profile from the top right corner. 

Click on your profile icon to open the dropdown menu where you can manage your 

account. 

3. Choose 'Help' from the dropdown menu. 

In the dropdown menu, select 'Help' to access a range of support resources designed to 

assist you. 
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4. Navigate the Help Section. 

The Help section is organized into two categories to help you find the information you 

need: 

a. Admin: 

• Admin Video Tutorial: Watch this video for an overview of administrative 

features and tools. 

• Admin Tutorial PDF Download: Download this PDF for detailed guidance on 

performing administrative tasks. 

b. User: 

• User Video Tutorial: Watch this video for a guide on features available to 

users. 

• User Tutorial PDF Download: Download this PDF for comprehensive 

instructions tailored to user needs. 

 

 

 

 

 

 

 

Looking for more ways to learn? 

Video tutorials provide a visual explanation, while PDF documents offer detailed written 

guidance. 

 



  

 

 

8. Changing your password 

18th Nov 2024  

If you need to change your password, the process is designed to be 

simple and straightforward. Just follow the easy steps provided, and 

you’ll be able to update your password with ease. If you encounter 

any issues or have questions, our support team is always here to help. 

a. Log in to the DrillBit application. 

a. Access your account by entering your current username 

and password. 

b. Go to Your Profile: Click on your profile icon located in 

the top right corner of the screen. 

c. Select 'Change Password': From the dropdown menu, choose  

the 'Change Password' option 
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6. Update Your Password: Enter your current password, then provide and confirm your 

new password. Make sure your new password meets these criteria: 

a. at least 8 characters long 

b. at least 1 uppercase and lowercase 

c. at least 1 number 

d. at least 1 special character 

5. Finalize the Change: Click 'Change Password' to update your password. 

 

 

 

 

 

Forgotten your Password? Select Forgot Password from the login page and DrillBit 

will send a password reset link to the email address registered to your account. 

 

 



  

 

 

9. Admin Announcements 

26th Nov 2024 

To Stay informed with ease using the Announcements feature in 

DrillBit Plagiarism. This tool allows Institution Admins to 

effortlessly get, share crucial updates and important information 

with all users across the institution.  

This feature ensures that all users receive timely and essential 

information, helping to keep everyone informed and aligned with 

institutional schedules and activities. 

1. Accessing Announcements: 

o Log in to the DrillBit application as an institution admin and navigate to the 

announcements section. 

 

2. Viewing Announcements from Admin’s Account: 

o Click on the "Announcements" icon to view announcements made by consortium 

product admins as well as announcements you have created. 
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3. Creating an Announcement for Users: 

o Click the "Plus +" icon to draft a new announcement. 

o Enter the title and content of your announcement. 

o Click "Submit" to post the announcement. 

 

 

Tabs Overview: 

 



  

 

 

1. Announcements Tab: 

The “Announcements” tab displays updates created by consortium product admins for 

all institution admins. This functionality ensures that important announcements from 

the consortium level are made available to all institution admins. 

 

2. My Announcements Tab: 

The "My Announcements" tab allows institution admins to view announcements they 

have created for users within their institution, providing a centralized location to 

manage and review their own announcements, and ensuring that important information 

is shared with everyone within their users.  

 

Announcements made by consortium product admins will appear in the 

"Announcements" tab, while announcements created by the institution admin for their 

users will be found in the "My Announcements" tab.  

 

Quick Tip: You can search for announcements by their title, streamlining the process of 

finding specific information quickly within DrillBit Plagiarism. 

 



  

 

 

10. Admin Dashboard 

26th Nov 2024 

The Admin Dashboard in DrillBit is your central hub for overseeing 

and managing your organization’s use of the platform. It provides a 

detailed view of user activity, submission statistics, and license 

management. With tools like Similarity Ranges, Account Validity, 

Trend Analysis, Document Types, and Departments, the dashboard 

is designed to offer you a clear and comprehensive overview. This 

way, you can easily monitor and manage every aspect of DrillBit’s 

usage, ensuring everything runs smoothly and efficiently within 

your organization. 
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1. Access the DrillBit application.  

a. On the login page, enter your username and password to sign in. 

2. Confirm that you are logged in as an admin. 

3. Upon login, you will be directed to the admin dashboard by default. 

Features of the Admin Dashboard 

10.1 Users: This section displays the number of users registered under your license compared 

to the total allocated by DrillBit. It helps you monitor user allocation and ensure 

compliance with your license limits. 

 

10.2 Submissions: This area highlights the number of submissions made by users under 

your administration, showing both the total submissions used and those allocated by 

DrillBit. 

 

10.3 Submission Overview: Track monthly submission activity by users under your 

account. This feature provides insights into submission patterns across different months. 

 

 



  

 

 

 

Year-Wise View: 

Analyse data from the past years to identify trends and patterns. This feature allows for 

year-wise data downloads in SVG, PNG, or CSV formats through the dropdown menu on 

the graph. 

 

10.4 Similarity Ranges: The Similarity ranges feature categorizes submissions based on 

detected similarity percentages, providing administrators with a clear overview of how  

Admin can download the month-wise graph of selected year in SVG, PNG, or CSV 

formats. 

 



  

 

 

many documents fall into each similarity range. This feature helps in assessing the 

originality of the submissions and spotting any documents that may have significant 

similarity or errors. 

• The similarity ranges report is available for download in SVG, PNG, and CSV formats 

via the hamburger menu on the graph. 

 

10.5 Account Validity: The dashboard displays the validity of the license in terms of the 

total duration and the remaining days until expiration. This ensures that administrators are 

always aware of the current status of their license and can take necessary actions before it 

expires. 

 

 



  

 

 

 

Renew your account: You can select the 'Renew your account' link to send a renewal request 

to DrillBit support. 

10.6 Trend Analysis: The Trend Analysis section displays the percentage distribution of 

similar work and own work across all submissions under the account. This visualization 

helps administrators understand the extent of similarity within the submissions. 

 

You can download the account validity report in SVG, PNG, and CSV formats through 

the hamburger menu located on the graph. 

 

 



  

 

 

Trend Analysis data can be exported in three formats (SVG, PNG and CSV) from the 

hamburger menu on the graph. 

10.7 Document Types: A pie chart visualizes the various types of documents submitted, 

including thesis, dissertation, article, and others. This feature enables administrators to 

analyse the diversity of submissions and identify which types are most frequently used. 

 

 

  

10.8 Departments: The Departments section allows administrators to view submission 

activity based on departments, such as EC, CS, IS, and others. This pie chart helps identify 

which departments have higher or lower submission activity. 

 

 

You can download the document types of data in SVG, PNG, and CSV formats by 

using the hamburger menu on the graph. 

 

 



  

 

 

 

The departments data can be downloaded in SVG, PNG, and CSV formats from the hamburger 

menu present on the graph. 

 

 

Here’s a useful feature: 

      Data for the Submission Overview, Similarity Ranges, Account Validity, Trend 

Analysis, Document Types, and Departments can be downloaded in three formats from 

the hamburger menu on each Individual graph: 

• SVG (Scalable Vector Graphics): Ideal for high-resolution, scalable graphics, making 

it perfect for presenting data clearly at any size. 

• PNG (Portable Network Graphics): Provides a clear, high-quality image suitable for 

digital displays, allowing data to be easily shared or embedded. 

• CSV (Comma-Separated Values): Exports the data in a tabular format for easy 

analysis in spreadsheets. 

 

 



  

 

 

 

11. All About User Management 

26th Nov 2024 

Managing users in DrillBit is straightforward. This guide will assist 

you with each step of the process. Start by logging in with 

administrator credentials and navigate to the 'Users' section to get 

started. 

Overview of User Information 

In the Users section, you’ll find a comprehensive list of all users. 

This includes Username, Email, Designation, Department, Creation 

Date, Allocated Submissions, Status, Statistics, and available 

Actions. 

The Active Users and Inactive Users are now displayed in separate tabs, making it easier to 

manage users based on their status. 

 

You can use the search bar to find a user by entering their email address.  

Sorting User Information 

The sorting option is available for Name, Email, Designation, Department, and Creation Date, 

allowing you to sort and view the information more efficiently. 
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To use sorting, click on the arrow next to any of the fields: Name, Email, Designation, 

Department, and Creation Date. 

 

Actions for Managing Users 

Here’s what you can do with user accounts: 

1. Reset Password: If a user does not receive a credentials through email when added by 

the admin or has forgotten their password, the admin can resend a password reset link to 

help the user regain secure access to their account. 

 

2. Edit: Keep user profiles current by updating details such as designation, department, 

phone number, expire date and document allocation. 

 

3. Delete: If a user is no longer part of the system or their account needs to be removed, 

admin can delete their account. This action will remove the user's access and data from 

the system. 

4. Activate/Deactivate: Admins can activate or deactivate a user's account using the toggle 

button. Use this feature to temporarily disable a user’s access or to reactivate their 

account when needed. 

The email address cannot be modified. 

 

Additional Password Reset Option: Users can also reset their password independently 

by selecting the "Forgot Password" option on the login page. 

 

 



  

 

 

 

5. Statistics:  

 

The account will also be automatically deactivated when the selected expiration date 

is reached. 

When a user attempts to log in with an account that has been deactivated by the admin, 

they will receive the following message: ‘Dear [Username], your account has been 

disabled by your administrator. Please contact your administrator to reactivate your 

account’. 

 



  

 

 

• User Statistics: When you click on the Statistics icon, a detailed pop-up window will 

appear, offering an in-depth look at the user's activity and data. This window displays 

two graphs: Submissions and Trend Analysis. 

 

o Submissions Graphs: These graphs provide a visual representation of the user's 

submissions over time, displayed month-by-month in a bar graph format. This allows 

admin to quickly assess submission patterns and activity levels. A convenient 

hamburger menu in the corner of the graph enables you to download the data in multiple 

formats, including SVG, PNG, and CSV, for further analysis or reporting.  

 

o Trend Analysis Graphs: The Trend Analysis section displays the percentage 

distribution of similar work and own work across all submissions under the account. 

This visualization helps administrators understand the extent of similarity within the  

 



  

 

 

submissions. Like the Submissions Graphs, the Trend Analysis Graphs also feature a 

hamburger menu for easy downloading in SVG, PNG, and CSV formats. 

 

Furthermore, within this pop-up window, there is an "Export to CSV" option. This feature 

allows you to download a comprehensive CSV file containing detailed information about the 

user's submissions.  

 

The CSV file includes various data points such as the author's name, title of the 

document, similarity score, AI score, file size in kilobytes, number of pages, paper ID, 

folder name, submission date, repository status, email, folder ID, document type, file 

name, language, college name, and grammar check results.  

 



  

 

 

• Download User List: Click the download icon at the top to obtain a CSV file containing 

details such as User/Account ID, Name, Email, Creation Date, Status, Documents 

Allotted, Documents Submitted, Date of Expiry, and Department. 

 

• Delete Multiple Users: An option to Delete Multiple Users is available in both the 

Active and Inactive Users tabs. When multiple users are selected by clicking the 

checkboxes, a delete option will appear at the top, allowing the admin to delete multiple 

users simultaneously. 

 

 

 

 

 



  

 

 

12. Adding a User Under Admin 

18th Nov 2024 

Log in to your DrillBit account with Admin credentials, navigate to 

the Users section and click on the + icon to add a new user under the 

admin account. Users can be added in two ways under the admin 

role: 

 

11.1 Add User: The admin can add a single user by entering         

details such as Name, Email Address, Department, Designation,  

Phone Number, and Expiry Date. Allocate the required number  

of documents, and, if applicable, grammar documents. 
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11.2 Add Multiple Users: Admin can add multiple users by uploading a CSV file containing 

the necessary information. 

• Download Template: Start by downloading the template, filling in the required fields, 

and uploading it. 

 

▪ Once the file is uploaded, a preview displays the user details, including SL No, Name, 

Email Address, Number of Submissions, Department, Designation, Phone Number, 

and an option to Delete individual entries. 

 

 

 

To add a user, the fields for Name, Email address, and Expiration date are mandatory and 

must be filled in. 

 



  

 

 

▪ Before submitting, you can edit any field in the preview to ensure accuracy, then click 

Submit to finalize adding the users. 

 

If email addresses are repeated, the preview will display the message: "Please remove the 

repeated email addresses and then proceed." 

 

 

o Ensure that the mandatory fields in the CSV file are filled: Name, Email Address, 

Number of Submissions and Number of Grammar Submissions. 

o Ensure that the CSV file follows the specified format. Files with additional columns 

or formatting changes will not be accepted. 

o An admin can add up to 100 users at a time using a CSV file. 

• CSV File Upload Errors: For information on resolving errors during CSV uploads 

when creating multiple users, refer to the "CSV File Upload Errors" documentation. 

 

 



  

 

 

 

If more than 100 users are added, the preview will display the message: "Your entries are 

more than 100, please delete the remaining. 

 

 

 

 



  

 

13.Admin Reports 

29th Nov 2024 

The Reports feature provides administrators with powerful tools to 

generate in-depth reports on user activity within the application. You 

can customize these reports to highlight specific users, folders, or 

submission data, ensuring you have all the insights needed to 

effectively manage and monitor plagiarism detection. With these 

reports at your fingertips, you'll have a clearer view of activity and 

trends to keep everything running smoothly. 

Steps to Generate Reports 

1. Access the Main DrillBit page 

o Begin by logging into your DrillBit account as an 

administrator. 

o Navigate to the Reports section in the application interface. 

 

2. Users List: 

o Download a comprehensive CSV list of all users within the institution. 
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o Click the download button to generate and download the list of users which includes 

both active and inactive users. 

 

3. Generate Custom Reports 

• Choose Reports: Select the type of report you want to generate: 

a. Folders: Analyse reports based on the folders created by users. 

 

  

Here's a helpful detail: The downloaded data will include comprehensive information 

for each user, such as User/Account ID, Name, Email, Creation Date, Status, Documents 

Allotted, Documents Submitted, Grammar Documents Allotted, Grammar Documents 

Submitted, Date of Expiry, and Department. 

The CSV file contains additional details, including User/Account ID, Name, Email, 

Creation Date, Status, Documents Allotted, Documents Submitted, Grammar 

Documents Allotted, Grammar Documents Submitted, Date of Expiry, and Department. 

 



  

 

 

 

After setting your parameters, click on the View & Download button to preview the report. 

You can then use the Download option to save the folder report to your device. 

 

 

b. Submissions: Focus on the reports generated from the submissions made by 

users.  

Report Details: When generating a report for folders, you will receive information 

including Folder Name, Folder ID, associated Email, Created Date and End Date. 

 

 



  

 

 

 

Once you have configured the parameters, select the ‘View & Download’ button to preview 

the report. 

 

1. Original File Download: This includes a download icon that allows administrators 

to download the original file that was uploaded by the user for plagiarism checking. 

This could be an assignment, research paper, thesis, or any other type of document 

that requires plagiarism verification. 

2. Similarity Report Download: A download icon is available for obtaining the 

similarity report. This report provides detailed results of the plagiarism check, 

including the percentage of similarity detected in the submitted document. It 

highlights the matched content and identifies the sources from which the content 

might have been derived, such as publishers, websites, or other documents.  

 



  

 

 

3. Submissions Download: The option to download submissions is also available at 

the top right corner. Clicking the download icon for submissions opens a popup 

window where you can enter any email address.  

 

 

After entering an email, a link to a CSV file containing the detailed submission 

report will be sent to the specified email address.  

 

 

Common Steps for Both Reports: 

• Choose Users: Enter a specific user or select 'All' to view overall submissions or 

folders within the selected date range. 

• Choose From Date / Choose To Date: Define the period for the report by entering 

the start and end dates. 

Submission Report Details: The CSV file containing the detailed 

submission report will include the following data: Author Name, Title, 

Similarity, AI Score, File Size (in KB), Pages, Paper ID, Folder Name, 

Submitted Date, Repository Status, Email, Folder ID, Document Type, 

File Name, Language, College Name, and Grammar. 

 

you can download a report for the past 6 months. 

 



  

 

 

14.DrillBit Repository 

18th Nov 2024 

A repository in the context of plagiarism detection and academic 

integrity, is a centralized storage system where documents and 

other types of content are collected, stored, and managed. Think 

of it as a comprehensive reference library, where each new 

submission is compared against this vast database to ensure 

originality. 

1. Navigating to the Repository in DrillBit Plagiarism 

After logging into your DrillBit Plagiarism account, you can 

access the repository by selecting the "Repository" option from 

the left sidebar. This section allows you to manage and upload 

documents for plagiarism detection, categorized into Institution 

and Global Repositories. 

a. Institution Repository: 

 

o Designed for content submitted within a specific 

institution or organization. It helps detect plagiarism 

by comparing new submissions against past work 

within the same institution, ensuring academic 

integrity among students and faculty. 

b. Global Repository: 

 

o Provides access to a broader range of content, 

including published works, journal articles, 

newspapers, theses, research papers and more from 

various institutions and sources globally. It allows for 

a more comprehensive plagiarism check by 

comparing submissions against a vast range of 

external sources. 
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• Files uploaded by both users and admins in the repository will be displayed on 

the page for easy access and management. 

• Administrators can delete files from the repository by clicking the delete icon 

next to the file. 

 

 

 

 

 

 

You can search for a paper by entering its unique paper ID in the search bar. 

Sorting: The sorting option is available for Paper ID, Name, Email ID, Title, Language, 

and Added Date. To use sorting, click on the arrow mark next to each field. 

 



  

 

 

15.Managing Repository 

18th Nov 2024 

Managing Files in the Repository: 

To upload a new file, click the "+" icon in the repository section. 

 

Uploading Files to the Repository 

Administrators have the flexibility to upload documents to the repository through three 

methods, each designed to accommodate different needs and preferences: 

a) Upload from Device: 

o Allows users to directly upload files stored on their local devices. It is ideal for 

quickly adding individual documents to the repository. 
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To ensure that documents are correctly catalogued and searchable within the repository, users 

are required to provide specific details during the upload process: 

• Author Name: The name of the individual who authored the document. This 

information is crucial for proper attribution and future reference. 

• Title: The title of the document, which helps in identifying and retrieving the document 

during searches. 

• Year: The year of publication or creation, which can be used to track the document's 

relevance and timeline. 

• Repository: Users must specify whether the document should be stored in the Global 

Repository or the Institution Repository, depending on the desired scope of plagiarism 

checks. 

• Language: The language in which the document is written, with options for English 

and Non-English, ensuring accurate processing and analysis. 

• Exempt Similarity Check: An optional checkbox that, when selected, excludes the 

uploaded document from being compared in future plagiarism checks. This is useful for 

original research or confidential documents that should not be part of the comparative 

analysis. 

b) Upload from Google Drive: 

o For those who store their documents in the cloud, this option facilitates easy 

uploads directly from Google Drive, but users will need to sign in to their Google  

• Supported file formats include .pdf, .doc, and .docx. 

• Users can upload up to 15 files simultaneously. 

• Each document can be up to 800 pages in length. 

• The maximum file size for each document is 100 MB. 

 



  

 

 

Drive account first. This is especially convenient for users who work across 

multiple devices. 

 

o During the upload process, you'll need to provide details such as the author’s name, 

title, and year of the document. Additionally, you must specify whether the 

document should be stored in the Global Repository or the Institution Repository 

and select the language of the document. 

c) Upload ZIP Files: 

o This method allows you to upload multiple documents compressed into a single 

.zip file. It is particularly useful when handling large volumes of documents or 

when organizing files into categories before upload. 

 

• Supported file formats include .pdf, .doc, and .docx. 

• Users can upload 1 file at a time. 

• Each document can be up to 800 pages in length. 

• The maximum file size for each document is 100 MB. 

 

 



  

 

 

o You will need to select the Repository (Global or Institution) and the Language of 

the documents. 

 

 

Click the "Submit" button to upload a ZIP file. 

 

 

 

 

 

 

 

• Supported Compressed File Format: .zip (limited to .doc, .docx, .pdf files) 

• Non-Supported Compressed File Formats: .rar, .tar, .7z 

• Documents: Up to 100 files in a single zip 

• Document Length: Up to 800 pages 

• Document Size: Up to 100 MB 

 



  

 

 

16.Integrations  

28th Nov 2024 

The Integrations section in DrillBit Plagiarism, accessible from the 

left sidebar of the application interface, allows administrators to 

connect DrillBit with various Learning Management Systems 

(LMS) to streamline the plagiarism detection process. This section 

supports multiple integration options, ensuring seamless 

functionality within your institution's educational infrastructure. 

Supported Integrations 

DrillBit Plagiarism currently supports the following integrations: 

• Moodle Plug-In Integration 

• Canvas LTI Integration (v1.3) 

• Blackboard LTI Integration (v1.3) 

• Brightspace LTI Integration (v1.3) 

• Moodle LTI Integration (v1.3) 

These integrations enable users to submit their documents directly through their LMS, were 

DrillBit checks for plagiarism. The results are then easily accessible within the LMS 

interface. 

Setting Up Integrations 

To set up an integration between DrillBit Plagiarism and your institution’s LMS, follow  

these steps: 

1. Log in to DrillBit as an administrator. 

2. Navigate to the Integrations section. 

Support         

Materials  

Integrations 

Admin Dashboard 

Managing 

Repositories 

Account security 

settings 

Logging in to 

DrillBit Plagiarism  

  

 

  

  

 

 

 

 

 



  

 

 

3. Select the desired LMS integration from the list of supported platforms: 

o Moodle Plug-In Integration 

o Canvas LTI Integration (v1.3) 

o Blackboard LTI Integration (v1.3) 

o Brightspace LTI Integration (v1.3) 

o Moodle LTI Integration (v1.3) 

 

4. Enable the integration: Toggle the switch for your selected platform. You'll then be 

prompted to enter specific details. 

5. Enter the required details and ensure they are accurate to establish a successful 

connection between DrillBit and the LMS. 

 

 

 

 



  

 

 

17.Integration Setup Guide 

18th Nov 2024 

This document provides specific, step-by-step instructions for 

integrating DrillBit Plagiarism with various Learning Management 

Systems (LMS). Each guide includes activation details, 

configuration steps, and post-integration features. 

• Navigate to the Integrations section in DrillBit. 

• Toggle the activation button for the desired integration to 

establish connection from DrillBit to selected Integration. 

 

17.1 Moodle Plug-In Integration: 

Moodle Plug-In Integration enables seamless connection between DrillBit and Moodle LMS, 

allowing users to submit documents directly through Moodle for plagiarism checks. This 

integration ensures efficient workflows and accessible results. 
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To activate the integration, toggle the activation button for the Configuration. You will then 

be prompted to fill in details such as Name, Email, Phone Number, and Moodle LMS URL. 

Once these fields are completed, click on ‘Submit’ to establish the connection. 

The Moodle LMS URL is used to link DrillBit with the Moodle LMS instance. This URL, 

along with other required details, ensures the seamless submission of documents from Moodle 

for plagiarism checks and connects to the correct DrillBit system for managing and processing 

submissions. 

 

 



  

 

 

After successful configuration, a "Know More" link will appear. Click on this link to view the 

configuration details.  

You will see information such as the API Key, College Name, Configured Date, and Moodle 

LMS URL, as well as the Technical Contact Details, including Name, Email Address, and 

Phone Number.  

 

To make changes to the configuration, click on the ‘Change Configuration’ button.  

 

 



  

 

 

A side tab will open, allowing you to update details like Name, Email, Phone Number, and 

Moodle LMS URL. After making the necessary changes, click on ‘Submit’ to save them.   

 

17.2 Canvas LTI Integration (v1.3): 

The Canvas LTI Integration (v1.3) provides a seamless connection between DrillBit and 

Canvas LMS, allowing users to submit documents directly through Canvas for plagiarism 

checks. This integration ensures easy access to results within the LMS environment. 

Activating the Integration 

To activate the Canvas LTI Integration: 

1. Toggle the activation button for the Canvas LTI Integration.  

 

The Moodle LMS URL required for the Moodle Plug-In Integration is a specific URL 

provided by DrillBit: moodle.drillbitplagiarismcheck.com. 

 



  

 

 

 

2. A side scroll bar will appear. Fill in the required details to establish the connection: 

 

o Platform URL: The primary endpoint for communication between DrillBit and 

Canvas, provided by the Canvas LMS administrator. 

o Client ID: A unique identifier specific to your institution, provided by Canvas 

during the integration setup.  

 It is specific to your institution and cannot be modified once configured. 

 



  

 

o You will get the Platform URL, Auth Endpoint, Access Endpoint and Keyset 

Endpoint from Canvas during the integration setup. 

o Method: Choose the key exchange method to ensure secure data transfer: 

▪ RSA: Provides administrators with maximum control over cryptographic 

keys, ensuring secure communication for plagiarism checks. However, it 

requires manual management of the private/public key pair. 

▪ JWK_SET: JWK_SET is perfect for administrators who prefer a 

streamlined, automated key management process. By choosing JWK_SET, 

administrators ensure seamless and up-to-date communication for plagiarism 

checks, without the need for manual key management. 

After clicking Submit, the integration setup will be finalized. A ‘Know More’ link will then 

appear for further details.  

 

Endpoint Information: You will get the Access Endpoint, Auth Endpoint, Keyset 

Endpoint, and Platform URL from Canvas during the integration setup. To find these 

endpoints: 

1. Log in to your Canvas account as an administrator. 

2. Navigate to Account > Developer Keys. 

3. Select LTI Keys and click on the key associated with your DrillBit integration. 

4. The endpoints and Platform URL will be listed under the integration details. 

 



  

 

 

Clicking on this ‘know more’ link will provide you with detailed information about the 

integration configuration, including the Access Endpoint, Authentication Endpoint, 

Configured Date, Client ID, College Name, Keyset Endpoint, Email Address, Method and 

Platform URL. 

 

Additionally, a delete icon is provided in the interface. You can click this icon to remove the 

Canvas Integration if necessary. 

 

 



  

 

 

Updating the Configuration: 

To make changes to the existing configuration: 

1. Click on the Change Configuration button. 

 

2. A side tab will open, allowing you to update Platform URL, Auth Endpoint, Access 

Endpoint, Method and Keyset Endpoint. 

 

 



  

 

 

3. After making the necessary changes, click Submit to save them. 

17.3 Blackboard LTI Integration (v1.3): 

The Blackboard LTI Integration (v1.3) establishes a seamless connection between DrillBit and 

Blackboard, enabling users to submit documents for plagiarism checks directly through the 

Blackboard environment. This integration facilitates easy access to the results within the LMS 

interface. 

 

To activate the Blackboard LTI Integration: 

1. Toggle the activation button for Blackboard LTI Integration. 

2. A side scroll bar will appear to fill in the required details. Complete the fields to 

establish the connection: 

 

 



  

 

 

o Platform URL: This URL is provided by the Blackboard administrator during the 

integration setup. It acts as the primary communication endpoint between DrillBit 

and Blackboard. 

o Client ID: A unique identifier provided by Blackboard for the DrillBit integration. 

Extra Information: It is institution-specific and cannot be modified after 

configuration. 

o You will get the Platform URL, Auth Endpoint, Access Endpoint, and Keyset 

Endpoint from Blackboard during the integration setup. 

o Method: Specifies the method for key exchange for secure communication. 

▪ RSA: RSA offers high security by giving administrators complete control 

over cryptographic keys. However, it requires manual management of 

private/public key pairs. 

▪ JWK_SET: JWK_SET simplifies the key management process by 

automating the key exchange, ensuring secure and up-to-date communication 

for plagiarism checks without manual intervention. 

Click on Submit to complete the integration setup. Once configured successfully, a ‘Know 

More’ link will become available. 

Endpoint Information: You will get a Access Endpoint, Auth Endpoint, Keyset 

Endpoint, and Platform URL from Blackboard during the setup. To locate these 

endpoints: 

1. Log in to your Blackboard account as an administrator. 

2. Navigate to Admin Panel > LTI Tool Providers. 

3. Select the tool associated with DrillBit. 

4. The endpoints and Platform URL will be displayed in the integration details. 

 

 



  

 

 

 

 

Clicking this link will provide you with all the details about the integration, including the 

Access Endpoint, Authentication Endpoint, Configured Date, Client ID, College Name, Keyset 

Endpoint, Email Address, Method, and Platform URL. 

 

To modify the existing configuration: 

1. Click on the Change Configuration button. 

 

 

 



  

 

 

 

2. A side tab will open, allowing you to update the Platform URL, Auth Endpoint, Access 

Endpoint, Method, and Keyset Endpoint. 

 

3. Once the changes are made, click Submit to save the configuration. 

Additionally, you can click the delete icon to remove the Blackboard LTI Integration. 

 

 

 



  

 

 

 

17.4 Brightspace LTI Integration (v1.3): 

The Brightspace LTI Integration (v1.3) allows for a seamless connection between DrillBit and 

Brightspace, enabling direct document submissions for plagiarism checks from within the 

Brightspace platform. Users can easily access their plagiarism check results within the LMS 

interface. 

 

Activating the Integration 

To activate the Brightspace LTI Integration: 

1. Toggle the activation button for Brightspace LTI Integration. 

2. A side scroll bar will appear to fill in the required details. Complete the fields to 

establish the connection: 

 



  

 

 

 

o Platform URL: This URL is provided by the Brightspace administrator during 

the setup process and serves as the communication endpoint between DrillBit 

and Brightspace. 

o Client ID: A unique identifier provided by Brightspace for the DrillBit 

integration. 

Extra Information: It is specific to your institution and cannot be changed once 

configured. 

o You will get the Platform URL, Auth Endpoint, Access Endpoint, and Keyset 

Endpoint from Brightspace during the integration setup. 

Endpoint Information: You will receive the Access Endpoint, Auth Endpoint, Keyset 

Endpoint, and Platform URL from Brightspace during the setup process. To find these 

details: 

1. Log in to your Brightspace account as an administrator. 

2. Navigate to Admin Tools > External Learning Tools. 

3. Select the integration for DrillBit. 

4. The endpoints and Platform URL will be listed in the integration settings. 

 



  

 

 

o Method: Specifies the method for secure key exchange. 

▪ RSA: RSA ensures secure communication with full control over the 

cryptographic keys but requires manual key management. 

▪ JWK_SET: JWK_SET offers an automated, hassle-free key management 

process, ensuring continuous and secure communication for plagiarism 

checks. 

Then click on Submit to finalize the integration setup. After successful configuration, a ‘Know 

More’ link will appear. 

 

Clicking this link will display detailed integration information, including the Access Endpoint, 

Authentication Endpoint, Configured Date, Client ID, College Name, Keyset Endpoint, Email 

Address, Method, and Platform URL. 

 

 



  

 

 

To update the configuration: 

1. Click on the Change Configuration button. 

 

2. A side tab will open, allowing you to modify the Platform URL, Auth Endpoint, Access 

Endpoint, Method, and Keyset Endpoint. 

 

3. Click Submit to save the updated settings. 

 



  

 

 

You can also use the delete icon to remove the Brightspace LTI Integration. 

 

17.5 Moodle LTI Integration (v1.3): 

The Moodle LTI Integration (v1.3) ensures smooth communication between DrillBit and 

Moodle, allowing users to submit documents for plagiarism checks directly through Moodle. 

Results are easily accessible within the Moodle environment. 

 

Activating the Integration 

To activate the Moodle LTI Integration: 

 



  

 

 

1. Toggle the activation button for Moodle LTI Integration. 

2. A side scroll bar will appear to fill in the required details. Complete the fields to 

establish the connection: 

 

o Platform URL: This URL is provided by the Moodle administrator during the 

setup and serves as the communication endpoint between DrillBit and Moodle. 

o Client ID: A unique identifier provided by Moodle for the DrillBit integration. 

Extra Information: It is institution-specific and cannot be modified once 

configured. 

 

 

 

 

  

 



  

 

 

o You will get the Platform URL, Auth Endpoint, Access Endpoint, and Keyset 

Endpoint from Moodle during the integration setup. 

o Method: Specifies the method for secure data exchange. 

▪ RSA: RSA is suitable for administrators who prefer maximum control 

over key management but requires manual handling of private/public key 

pairs. 

▪ JWK_SET: JWK_SET provides a dynamic and automated solution for 

key exchange, making the process simpler and more efficient. 

Then click on Submit to finalize the integration setup. After successful configuration, a ‘Know 

More’ link will appear. 

Endpoint Information: You will receive the Access Endpoint, Auth Endpoint, Keyset 

Endpoint, and Platform URL from Moodle during the setup. To locate these endpoints: 

1. Log in to your Moodle account as an administrator. 

2. Go to Site Administration > Plugins > External Tools > Manage Tools. 

3. Select the integration for DrillBit and click on view configuration details. 

 

4. The endpoints and Platform URL will be available under integration settings. 

 



  

 

 

 

Clicking this link will reveal integration details, such as the Access Endpoint, Authentication 

Endpoint, Configured Date, Client ID, College Name, Keyset Endpoint, Email Address, 

Method, and Platform URL. 

 

To modify the configuration: 

1. Click on the Change Configuration button. 

 

 



  

 

 

2. A side tab will open, allowing you to update the Platform URL, Auth Endpoint, Access 

Endpoint, Method, and Keyset Endpoint. 

 

3. Click Submit to save the changes. 

You can also click the delete icon to remove the Moodle LTI Integration. 

 

 



  

 

 

18.Account Security Settings 

18th Nov 2024 

The settings section offers essential security feature, such as Multi-

Factor Authentication (MFA), to help safeguard your account and 

enhance your overall security. 

Multi-Factor Authentication (MFA) for Security 

To enhance the security of administrator accounts, DrillBit has 

implemented Multi-Factor Authentication (MFA). MFA adds an 

extra layer of protection goes beyond just a password, requiring an 

additional verification step to significantly reduce the risk of 

unauthorized access. Enabling MFA is a simple step that greatly 

strengthens your account’s security. 

Steps to Enable Multi-Factor Authentication (MFA) 

1. Log in to DrillBit as an administrator. 

2. Navigate to the settings section on the left sidebar of the application. 

3. In the Multi-Factor Authentication section, you will see the option to enable  

MFA. 

 

4. Toggle the switch to enable MFA. 
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5. A pop-up window will appear asking, "Are you sure you want to activate Multi-Factor 

Authentication?" Select Yes to confirm. 

Login Process: After MFA is enabled, administrators will first enter their password when 

logging in. Following successful password entry, an OTP will be sent from DrillBit to the 

administrator’s registered email address. The administrator must then enter this OTP on the 

login page to complete the authentication process. 

 

 

Additional Information: If you need to disable MFA, you can do so by toggling the 

switch off in the same settings section. A confirmation pop-up will appear with the 

message, "Are you sure you want to deactivate Multi-Factor Authentication?" Select Yes 

to confirm and deactivate MFA. 

Ensure your registered email address is correct to avoid issues with receiving OTPs. 

After 3 consecutive incorrect attempts to enter the OTP, you will need to log in again 

and request a new OTP. 

 



  

 

 

19. Support Centre 

18th Nov 2024 

The Support functionality offers a streamlined ticketing system 

crafted to handle any queries or issues administrators might 

encounter. This system is designed to help you efficiently report 

problems and get the assistance you need, ensuring that your 

concerns are addressed quickly and effectively.  

Creating a Support Ticket 

1. Access the Support Centre: Start by navigating to the 

Support Centre within the DrillBit application. This section 

allows you to submit support tickets and track the status of 

existing ones. 

 

2. Initiate a New Ticket: Click the plus icon to begin creating a new support request. 

This is where you start your journey to getting the help you need.  

3. Complete the Ticket Form: 
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a. Issue Category: Choose the appropriate category for your issue, such as Technical, 

Billing, Account, General, or Others. Selecting the right category ensures the 

request is routed to the correct team. 

b. Priority: Set the priority level of your ticket—High, Medium, or Low— to indicate 

how urgently you need assistance. 

c. Subject: Provide a brief, clear subject line for your ticket to quickly convey the 

main issue. 

Description: Enter a detailed description of the issue or query being faced. The 

more detail provided, the better the support team can understand and address the 

concern. 

Contact Number: Provide a contact number where further information can be 

requested if needed. 

Attachments: Attach any relevant files that could help resolve the issue. 

4. Submitting the Ticket: 

o Once all required fields are completed and any necessary files are attached, click 

the “Create Ticket” button to submit the ticket. 

 

Supported file formats for attachments include JPG, PNG, and JPEG, with a maximum 

file size of 10 MB. 

 



  

 

 

Tracking and Managing Tickets: 

1. View Submitted Tickets: All submitted tickets can be viewed in the Support section, 

providing an overview of each request made. 

2. Sorting: Sorting has been added for Ticket ID, Subject, Created Date, Priority, and 

Issue Category. To use sorting, click on the arrow mark next to each field. 

 

3. Monitor Ticket Status:  

• The ticketing system provides updates on the status of tickets, allowing progress 

to be monitored effectively. 

 

• To continue a conversation related to a ticket, click the arrow to dive deeper into 

the ticket. This opens a chat where further comments can be made, and direct 

communication about the issue can take place. 

 

 

 



  

 

 

 

 

By utilizing the ticketing system in DrillBit Plagiarism, administrators can ensure that any 

issues or queries are addressed promptly and effectively, maintaining smooth operation and 

support for your institution's plagiarism detection needs. 

 

 

More to Know: When you access a raised ticket, you can view all its details, including 

the Ticket ID, Priority, Status, Created Date, Ticket Category, Contact Number, and 

Organization. Additionally, any attached files can be downloaded directly from the 

conversation. 

 


